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Roof Designer
The Roof Designer makes it easy to define and place custom roofs in your project.
You can start the Roof Designer independently, from the myHouse program group,
by clicking Start and then selecting Roof Designer. You can also start the Roof
Designer from within myHouse by clicking the Roof icon on the horizontal toolbar;
then click the Automatic Roof Designer or Roof Designer icons of the vertical toolbar
at the left side of the screen.
The Roof Designer program works in several windows. With its help, you can design
independent or appropriate roofs to a given floor plan or you can design special
ground surfaces. The program shows the process of designing in several windows,
but at the same time, you can only design in the one active window. The Roof
Designer program starts with the window shown in Figure 1.

 Figure 1. The main window of the Roof Designer program
To open the editor-windows, you may click on the  icon or call the Window menu

item. Clicking on the  icon, the four editor-windows open together, as shown in
Figure 2.
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Figure 2. The window arrangement of the Roof Designer

Note: there is a detailed description of the Roof Designer’s window commands in the
following section.
The screen is divided into the following parts:
� Upper menu line:

File Edit View Options Window Help
� Upper icon line

                   
� Lower information line: X, Y coordinate location of the cursor for accurate

editing. You may see the values in cms or inches.
� The four editor-windows

The editor windows are as follows:
Top view (X,Y)
Front view (X,Z)
Side view (Y,Z)
and 3D view, axonometric window

Let’s now see the elements in more detail.

1 The Upper menu  line

The following new menu appears with the editor windows:
File Edit View Options Window Help
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1.1 File menu commands:

In the File menu, the following commands are executable:
New Starting & Editing a new roof
Open Loading a saved roof
Save and exit Suspending the editing and closing the roof
Save Saving an edited roof
Save As… Saving the edited roof into new file
Import roof Loading a roof saved in a R3D file format
Export roof Saving the edited file in a R3D file format
Exit End of roof-editing

Figure 3. The File menu commands

1.1.1 New Starting and Editing a new roof

You can start a new roofplan by calling the New command. A roof can consist of three
parts:

The roof;
The roofedge-contour layer;
The wall-contour layer.

The roof can consist of dots, lines, or planes placed in the space. A so-called roofedge-
contour layer can form part of a roof. You can load it to the roof-editor from a saved
file or make any shaped roofedge-contour with the program. In the Top view (X-Y),
the roofedge-contour contains a series of contours (lines or arcs), which depict an
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enclosed polygon, which is usually this is the perimeter of the roof. By calling the
automatic new roofeditor, the program keeps these series of contours – in place,
where existing previously – and you can then design a new roof around it. This
contour polygon also helps the automatic roof-editor in auto-editing. In these
circumstances, you have to add a roof plane definition to the contour-polygon (see
chapter 4). Otherwise you don’t need the contour polygon. But for auto-editing, you
can use it as a guide for the roof-plan to help the editng process. In the same way,
the editing can be guided by the wall contour layer that you can obtain from the
myHouse program’s floor-plan editor,  which contains the constructional contour
(perimeter) of the building. You can use it also as a guide for the editing process, but
it is not part of the new roof itself. The contour layers overlay the X-Y plane in the
Top view (X-Y) window, where they are most visible and helpful.

1.1.2     Open Loading a saved roof

You can load an edited roof saved in name.DEF file format with the Open command.

Figure 4. Open window
In the Open window, you can choose the required file from the desired directory and
then, you can load it to the roof-editor. When you save an edited roof, all data about
the roof is saved in a name.DEF file format. You can simply load these saved files
by choosing this command. The file contains the roof
and its adherent contours also.

1.1.3     Save and Exit      Suspending the editing and closing the roof

If you wish to stop the editing on the roof shown on the screen, just click on the
Close command. If you worked on the roof and have not saved it, the program will
save the changes if you answer “yes” per as noted below.

Figure 5. The window that appears when closing
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How to answer:
Yes in this case all changes will be saved in the file whose name is shown on the
top line, overwriting the previous version of the file.
No in this case the plan will not be saved, all changes will be lost and you are
exited from the plan leaving the existing file unchanged.

1.1.4     Save Saving the edited roof

With this command, your roof plan will be saved in the file whose plan name is
shown on the top line of the program-window. During the save, the edited roofs will
be saved in a name.DEF file format. The saved file will contain the roof and also its
adherent contours.

1.1.5 Save As… Saving the edited roof into a new file

Figure 6. Save As… window
By typing the name of the roof-file into the File name field, the edited roof may be
saved into a new name.DEF file format. The file will contain the roof as well as its
adherent contours.

1.1.6 Import roof Loading a roof saved in a R3D file format

You can reload back a roof previously saved in R3D file format to the roof-planning-
module. During the  import, all the contour layers will be cleared from the screen
and only the roof will be loaded from the R3D file. The Modeler 3D program can
also open the R3D file format and with its help, you can link the models made by
the roof editor to a library.

1.1.7 Export roof Saving the edited file in a R3D file format

You can save the roof without its contour lines and with the help of the MODELER
program, you can also place and save it into a library. The myHouse system supports
this library format, and so the roof is directly loadable as a ready library unit. That’s
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why you need to save the roof into a file type supported by the MODELER program;
i.e. the R3D file format which only contains the depictions of dots, lines, planes and
cuts.

1.1.8 Exit End of roof-editing

Use this command when you wish to finish your work on the roof shown on the
screen. If you edited the roof and have not saved it yet, the program will ask whether
you want to save the changes.

Figure 7. The window that appears when exiting.
How to answer:
Yes in this case all changes will be saved in the file which name is shown on the
topline overwriting the previous version of the file and exits from the program.
No in this case the plan will not be saved, all changes will be lost and exits from
the plan leaving the existing file unchanged and also exits from the roof-editor
program.

1.2 Editing

Figure 8. The elements of the Edit menu
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You can execute the following tasks from the Edit menu:
Undo Alt+Bkspc
Redo Shift+Alt+Bk
Cut Ctrl X
Copy Ctrl C
Paste Ctrl V
Delete Del
Roof Contour…
Select All Ctrl A

1.2.1 Undo/Redo functions

 The Undo and Redo functions serve to cancel a previously executed command or
execute a previously canceled command. The command which this function “undo’s”
or “redo’s” is shown in the menu line, so you can check the effects of the function in
advance, with the safety of simply undo-ing the effects of an undesired command.
Often times, instead of using the Delete function, it is more efficient to remove the
edited results in the plan with other program commands. In such a case, we recommend
using the Undo function. Example: a roof is shown on the screen. You wish to move a
few dots of it some centimeters away. You select the dots and move them.

Figure 9. Moving the dots
After the move, you realize that the dots you have moved are not the right dots. Using
the Undo function, you can restore the previous location of the dots. The command
relocates all the moved dots together. These are multilevel functions, which means
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there is a possibility to execute the Undo and Redo functions repeatedly. How many
times depends on memory size and the task you are working on. If the program cannot
step back, it tells you by changing the color of menu item to gray. All the above
applies similarly to the Redo function, but it performs the command that you have
previously cancelled via the Undo function. You can simply call these functions by
pressing Alt+Bkspc or Shift+Alt+Bk .

Figure 10. The effect of Undo

1.2.2 Cut Ctrl X

The Cut function (Ctrl X) – as in other programs – places the selected elements on
the Clipboard in such a way that it removes the selections from the plan. You can
also use Ctrl X hot-key to call this function.

1.2.3 Copy Ctrl C

The Copy function (Ctrl C) – as in other programs – places the selected elements
on the Clipboard in such a way that it leaves the selections in the plan. You can also
use Ctrl C hot-key to call this function.

1.2.4 Paste Ctrl V

The Paste function (Ctrl V) – as in other programs – places the elements from the
Clipboard into the plan. You can also use Ctrl V hot-key to call this function.
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1.2.5 Delete Del

The Delete function (Del) – as in other programs – removes the selected elements.
The selected elements can only be dots here. This function removes the lines and
planes created by the dots. You can also use Del hot-key to call this function.

1.2.6 Roof Contour…

In the Roof Contour… submenu, you may manage two types of contour layers.
These two types are:

Roofedge-contour layer which you design; and the
Wall contour layer transmitted from the drawing window of myHouse

You can execute many tasks under this function:
Clear own;
Clear import;
Create;
Remove.

Clear own
Using the Clear own, you can delete your roofedge-contour layers. The  roofedge-
contour layer
is shown in light blue on the screen.
Clear import
Using Clear import, you can delete the wall contour layer transmitted from the
drawing window of myHouse. The wall-contour layer is also shown in light blue on
the screen. When you save a roofplan in a name.DEF file format these contour
layers will also be saved. By starting a new roof plan, the contour layers will not be
cleared from the screen. You can clear them by calling the Roof Contour…/Clear
import function. However, please note that the clear import function will not be
executed, if you called the Roof Designer program directly from myHouse. In this
case, the wall contour layer is not clearable and the program leaves it on the screen
when you start a new roof plan.

Create Ctrl K
The Create function serves to create a roofedge-contour layer. In this case, there
must be an enclosed polygon on the X-Y plane. After selecting that polygon, the
Create function converts it to a roofedge-contour layer. The creation of a new polygon
on the X-Y top-view plane is done by creating dots and lines. Example: create a dot
on the X-Y plane at the crosshair or small arrow location by pressing the Insert key
or by choosing the Create dot here from the menu which appears by pressing the
right mouse button. (See Creating dots.) You may connect the dots with lines (see
Creating lines), which are available by pressing the C key or choosing the Connect
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menu item from the menu which appears by pressing the right mouse button after
selecting dots. Two dots can be connected with an arc. Between the two selected
dots, you can create an arc by choosing the Create Arc (see Creating arc) menu
item from the right mouse button menu . To create a roofedge-contour, the connecting
lines between the dots have to form an enclosed polygon. This polygon created on
the X-Y plane can be modified by the contour Create function. This polygon is
shown in light blue on the screen. The roofedge-contour layer also may play a role
in the design as an guide element. You can define a series of (rising) sloping roof

membranes  by calling the auto roof-generator and in this way – if it is
possible to construct – you can generate a whole roof in one step with its help. There
are numbers beside the lines which identify the definition of the sloping roofedge-
contour. You can assign numbers to the lines in the autogenerate roof menu. (See
Autogenerate roof.) The roof is built up of equal gradient planes using the sides of
lines marked with equal numbers.

Remove Ctrl D
With the help of Remove function, you can break the roofedge-contour layer into
dots and lines. The  roofedge-contour layer is shown in light blue on the screen. To
create them, you have to create dots and lines on the X-Y top-view plane. The lines
form an enclosed polygon. You will see numbers beside the lines which identify the
definition of the sloping roofedge-contour. By the sides of lines marked with equal
numbers, the roof is built up of equal gradient planes. During this process, the blue
line on the screen turns to black and the dots become visible and then, you can move
or delete them, or you can add more dots to the polygon, etc.

1.3 View command

With the View command, you can change the content of the view in the active
window. For example, we can switch the content of Top view (X-Y) window to the
Right view (X-Y) image. The effect of the process is shown in the Figure 11.
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Figure 11. Example of re-setting the view of active window
We mention here that you can enlarge the active window to the full screen by clicking
on (the second) icon in the upper-right corner of the window. As in other Windows
programs, switching back to a divided windows mode is available by clicking on the
replaced icon -- also the second small icon. The first corner icon is used to temporarily
close the program window, while the third one (X) is used for final closing. You can
set the View by clicking on the upper icon and choosing the right icon from the
pull-down menu            . (See Figure 12).

Figure 12. Setting of the View
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1.4 Options command

Figure13. Setting properties
Using the Options command, you can set the editor properties and the definition of
surface’s texture. The editor properties will be saved, and when restarting the
program, will load its last settings. The surface properties are available for the
whole roof.

1.4.1 Editor… Setting editor properties

Using the Editor… function, there are four properties you can set. These are as
follows:

View Setting editor properties
Directory Setting the plane-directory
Limits Setting the limits of the editor properties
Colors You can customize the drawing colors of the
elements of the editor. The roof and the stair editor uses the same color
settings.

1.4.1.1 View

To call this function, you choose the Editor… and the subcommands and the
following menu will appear (Figure 14.).
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Figure 14. The dialog box for entering the view options
The following properties are shown in the View menu:
Grid dot spacing. You can display grid dots on the screen. In this field, you may
give the distance between grid dots in a chosen measuring unit. You may have grid
dots display or not display by turning on/off the  icon in the upper iconline.
During the editing, you may also ask the program to snap to grid dots by also
clicking on the icon  in the upper iconline. You may shift the grid using the F5
function key. To shift the grid to a desired dot location, follow these steps: move the
cross-hairs to the dot or position where you would like to place a grid dot and push
the F5 function key or select the Place Grid Here function from the menu which
appears by pressing the right mouse button. The program will then redraw the whole
grid up/down left/right from this new origin using the grid space setting.
Dot Snap Sense Range: You can also set the sense range from your cursor to snapping
dots. You can choose from different snapping methods by clicking on the appropriate
icon      in the upper iconline.

With this icon, you turn on/off snapping to grid dots mode.
With this icon, you turn on/off snapping to existing dots mode.
With this icon, you turn on/off snapping to lines mode.

In changing the Dot Snap Sense Range (the maximum distance from cursor to dot
to snap to), the measurement must be given in screen pixels, and actual measured
distance will be dependent on your zoomed view. This setting affects the dot snap
mode.
Line Snap Sense Range: This setting affects the sensing range from cursor to your
snapping line. The measure must be given in pixels, so again, the actual measured
distance in cms or inches depends on your zooming plane. By clicking on the 
icon, you can turn on/off the line snap mode, and set the line snap sense range. With
the help of the line snap  icon, you can move or create dots on an existing line.
The line snap mode in the active view always refers to the view of the line projected
to the plane and not to the three-dimensional view. So if you wish the dot to definitely
be on a 3D line, you need to snap to the line in two views.
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Radius of displayed dots: The dots created on the screen are represented by small
circles. You may enter here the radius of those circles. Be careful that your radius is
not too large as it can complicate your editing.
Sense range for selecting and moving dots: You can select a dot or dots by framing
an area, while holding down the left mouse button. With this “plus range” setting,
the dot selection may also contain dots outside of that frame within the range of the
given pixel number. You can move selected dots by dragging them with the mouse,
holding down the left mouse button. This value also represents the distance (in
pixels) in which you can catch the dots to select them for moving.

1.4.1.2 Directory

The next item of the Options menu, Directory, allows you to enter the directory
name (or folder) where you want your files to be saved.

Figure 15. The dialog box for entering the directory name.

1.4.1.3 Limits

The next item of the Options menu is Limits, where you may enter maximum and
minimum values for your roof. This setting is dependent on the memory size and
the roof detail. They must be in accordance with each other, in order to be able to fit
the full roof definition values in your available memory.

Figure 16. Dialog box for entering the limits
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You can enter the following limits:
Dot number limit: In this field, you may enter a maximum number of dots for the
plan. The roof is now limited by this number of dots. You may add to this number if
needed by your roof detail, but the maximum is limited by your available memory.
Line number limit: In this field, you may enter a maximum number of lines for the
plan. The roof is now limited by this number of lines. You may add to this number
if needed by your roof detail, but the maximum is limited by your available memory.
Polygon number limit: In this field, you may enter a maximum number of polygons
for the plan. The roof is now limited by this number of polygons. You may add to
this number if needed by your roof detail, but the maximum is limited by your
available memory.
Dot limit per polygon: The maximum number of dots per polygon is 64. You cannot
change this limit.
Note that all changes to the above limites will take place after restarting the Roof
Designer program.

1.4.2 Surface properties

Using Surface properties, you can assign a characteristic texture to your roof plane.
When visualizing the 3D rendering, your roof would be covered with the pattern of
this surface property. To define a texture, adjust the settings per below in the dialog
box which will appear.

Figure 16a. Assigning a texture to the roof-surface
The settings of the dialog box are as follows:
Color button : press this to assign a homogenous color to the roof surface;
Textures: Textures are stored in BMP format files that may augment with additional
textures. To do so, place the new BMP file in the LIB directory and then note the
new file name in the Roof information section of the Texture.ini text file;
Width/Length: These parameters set the size to which you wish to stretch the pattern
shown on the display swatch before it repeats;
Rotation: adjusts the rotational angle of the pattern displayed on your roof plane;
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Material : You can change the material used for photorealistic rendering (ray-tracing).
These surface properties apply to the whole roof.

1.5 Window command

In the Window command, you can modify the size and location of the windows shown
on the screen. There are several arrangement options in the menu as follows:

Cascade arrangement
Tile arrangement
Arrange Icons
Close All
Show New
Show All Views

Figure 17. The menu of the Window command

1.5.1 Cascade arrangement
In the Cascade arrangement, the program displays windows stacked and cascading
from the top left to the bottom right of the screen as you can see in Figure 18.
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Figure 18. Cascade arrangement

1.5.2 Tile arrangement

In the Tile arrangement, the program displays windows edge to edge as you can see
in Figure 19.

Figure 19. Tile arrangement

1.5.3 Arrange Icons

This function arranges the minimized windows within the main window. You may also
minimize a window by clicking on the first icon in the upper right corner.
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1.5.4 Close All

The selection closes every opened window.

1.5.5     Show New

With this command you can open a new window. The new window will appear in top
view mode.

Figure 20. Show new window

1.5.6 Show All Views

Use this command to display every view.

Figure 21. Show all views
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1.6 Help command

Subcommands:
Contents
About

1.6.1 Contents command

Using this command, you can ask for help at any time during the operation of the
program.

1.6.2 About command

Using this command, displays main information on the program itself, including its
version number.

2 Commands of the upper iconline
The following icons are shown in the upper iconline:
The first two icons – as in other programs – serve to quickly execute the Open and
Save commands.
The following icons:
                       

2.1  Open a new window

Here you can open a new window. By clicking on the  icon, a new top view
window appears.

2.2  Visualization of views

You can display the four views by clicking on the  icon. The editor windows are
as follows:

Top view X-Y,
Front view X-Z,
Side view Y-Z
and 3D-view, axonometric window.

Each of the four windows is an editing window, so it doesn’t matter which window
you use to work out the different steps of your editing. There are two ways of selecting
a window: a) simply click on the window you wish to select, or b) you can assign
any view from the          pull-down menu from the upper iconline to
be the active window. In the upper iconline, the active view window’s icon is always



Roof Designer-22

shown. You can also create two 3D-view windows.
1. The  axonometric view window shows you the front-view axonometrical

illustration of the roof. Its role in the editing is limited to selecting dots.
2. In the 3D  axonometric view window you can also rotate the roof shown in

the window. Its role in the editing is limited to selecting dots.

2.3  Creating, selecting and moving dots

If this icon is selected, you can create new dots or select and modify existing dots.
Note that you cannot create new dots or modify existing dots in the 3D axonometric
view window.

2.3.1 Creating new dots

If this  icon is selected, you can create new dots at your cursor locaton. There are
five ways of creating a new dot:
1. By clicking on the Create dot here in the right mouse button click pop-up

menu;
2. By clicking on the Create… menu item;
3. By pressing the Ins key;
4. By creating an arc;
5. By continuously creating a dot, a line or a polygon;
6. By auto editing.

2.3.1.1     Create dot here

If you click the right mouse button, a pop-up menulist appears (see Figure 22.). By
then clicking on a menu item,  the command gets executed.

Figure 22. The pop-up menulist when clicking the right mouse button
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By choosing the Create dot here menu item, a new dot appears at your cross-hairs (or
cursor) location.

2.3.1.2     Create…

If you click the right mouse button, a pop-up menulist appears (see Figure 22.). By
then clicking on a menu item, the command is executed. If you choose the Create…
menu item, a new window pop-up appears where you can adjust the offset values of
the new dot from your cross-hairs.

Figure 23.Specifying the offset values for a new dot
To specify the Horizontal/Vertical offset values a new menu window appears where
you can enter the offset values. The new dot will then be created offset with those
values from the cross-hairs’ position.

Figure 24. Entering the offset values
You can also enter altitude offset values of a dot, if you create the dot in the X-Y view
window. Choose the With Altitude menu item shown in Figure 23. then enter the
value in the display window. The new dot created in the active window will be offset
above the X-Y plane with the entered altitude value.

Figure 25. Entering the altitude value of a dot

2.3.1.3 By pressing the Ins key

This is the fastest and most comfortable way of creating a dot. Just move the cross-
hairs and/or the small arrow to the desired position and press down the Ins key. The
dot is created immediately.
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2.3.1.4 Creating a dot by creating arc

You can create a dot by creating arc.  To create an arc, you must select two dots. Then
click the right mouse button and choose the Create Arc… menu item in the pop-up
menu (see Figure 22.). One of the following two dialog boxes will appear depending
on the position of the two dots.

Figure 26. The necessary dialog boxes to define the direction of the arc
You must enter the following values in the dialog box:
Radius: The radius of the arc (in your chosen measure unit)
The Arc value is a semi-circle’s radius
Number of sections: The number of straight lines that connect the arc.
Please pay attention to the number of sections in order to avoid both the creation of
too many dots and un-smooth curves.
Connect Side: Select to connect the dots immediately.
Type: To define the direction of the arc.
By selecting your dots in a consistent manner by relative position, this setting will
help you get predictable results.

2.3.1.5     Continuously creating a dot, a line or a polygon

You can also create a dot by pressing down Ins key when the cross-hairs and the
small arrow are at the desired position. This is the fastest way of creating a dot and
is comfortable to use. The created dots are connected with lines. You can stop the
dot creation by clicking the right mouse button and you can close the polyline and
make a polygon by choosing from the right mouse click pop-up menu.

   Snapping algorithms
During dot creation, you can use snapping algorithms. To choose the snapping
option, click on the corresponding    icon.

With this icon you turn on/off, the snap to grid dots mode.
With this icon you turn on/off, the snap to existing dots mode.
With this icon you turn on/off, the snap to lines mode.

If you turn on a snap mode by clicking on its icon, then creating a new dot or You
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moving an existing dot will take the snapping mode into consideration. With the help
of snap modes, you can, for example, place a dot in line with other dots without
paying particular attention to the coordinates. Using snap modes, you can edit quickly
and more accurately. But of course in certain cases, there is no need to use snap
modes. To adjust the sensitivity of the snapping,  call up the Options/Editor…
command (see 1.4 Options command).

2.3.2     Selecting a dot

If the   icon is picked, you can select a dot or dots. It is very simple to select dots.
Click on the dot – represented by a small circle on the screen – which you wish to
select. To indicate your selection, the color of the dot will change to red. If there are
dots one above the other in the active view, then you can alternate dot selection by
hitting the Space bar. In other views, you can easily follow the selection of the
proper dot. You may select more dots one after another. To select both dots one
above the other select the dot twice. The selected dot or dots are red-colored. To
cancel the selection of a dot, you must reselect it.
You can select a dot or dots by framing an area. In this case, every dot, line and
plane in the frame will be selected. This selection is also indicated by changing the
color to red.

2.3.2.1 Moving dots
If you now wish to move the selected dots together on the screen, just pick one dot
and move it to the desired position and they will all move together. For moving the
dots you wish to switch to another window or view.
To improve the accuracy of your move, you have additional possibilities such as:
1. Changing move direction /Tab/;
2. Moving with offset according to selected dot or dots;
3. Moving to cross-hairs.
Changing move direction /Tab/ :

If you want to move the dots only horizontally or vertically, you may set a move
direction. You have two ways to do this. While pressing the left mouse button,
hit the Tab key and move the dots to the desired direction indicated on the
screen, or simply click the right mouse button and choose the Change move
direction menu item in the pop-up menu (see Figure 22). While moving dots,
the appearing mouse arrows show the selected move direction.

Moving with offset according to the selected dot or dots

Figure 27. Entering offset values for
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may move the dots with a measured offset from their existing position. Enter the offset
values in the dialog box shown in Figure 28.

Figure 28. Entering offset values for moving dots
Moving to the cross-hairs

You can also move a dot or dots to your cross-hairs.

Figure 29. Moving a dot to the cursor
Choose the Move…/To cursor menu item or then press the O (letter O) key.

In this process, the connecting lines and the planes will be shifted as well. If the
planes would deflect due to this move, the program will suspends the move with
an error indication, and you can decide whether you want to continue or not.

Figure 30. Error indication due to dot moving
If you answer Yes, the dots will be moved to their new position in such a way that
the deformed roof planes will be deleted from the roof. You may verify this by
visualizing the planes (S key). The planes defined by the polygons will be shaded
red, the roof contour polygon will get shaded green.

2.3.3    Deleting dots

To delete the selected dots, use the Del /Delete/ key or choose the Delete menu item
from the right mouse click pop-up menu. By deleting a dot or dots, the lines and
planes will also disappear from the roof. Before deleting the dots, you will receive a
warning asking if you really wish to delete the selected dots.

Figure 31. Confirming the deletion
If you deleted the selected dots in error, you may replace the dots by using the Undo
function.
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2.3.4  Selecting a polygon

After pressing the icon, you may select polygons in the active window. The tilt angle
of the polygon appears on the selected polygon. This function serves to provide you
with information only. If there are polygons one above the other, you may alternate
their selection plane by plane by hitting the Space bar and you will see the tilt angle of
each plane. The tilt angle of a created polygon which is defined as a plane is shown in
black, while for a polygon which is not defined as plane it is shown in red. (See
Chapter 3.8 Creating polygons)

2.3.5  Moving the plan in the active window

After selecting this icon, you can move the whole plan in the active window. While
holding the left mouse button down, you can dynamically position the whole roof
together with its contour lines. You may also position the plan by using one of the 

   icons or Ctrl+, Ctrl- or Ctrl Shift E hot keys. This movement does not
really move the plan, only the visible area changes.

2.3.6  Rotating the 3D-view

To rotate the roof, click on the  icon and while pressing down the left or right
mouse button (depending on your desired rotation direction) simply move the mouse.

2.3.7  Changing views

You may choose any view from the           pull-down menu placed in the
upper iconline. (See Figure 32.)

Figure 32. Changing views.
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With the help of View icon, you can change the content of the view image in the active
window. For example, let’s replace the content of the active Top view X-Y window with
the Right view Y-Z image. See the changes in Figure 33.

Figure 33. Example for selecting the right view in the actual window
We mention here that you can enlarge the active window to the full screen by clicking
on (the second) icon in the upper-right corner of the window. As in other Windows
programs, switching back to a divided windows mode is available by clicking on the
replaced icon -- also the second small icon. The first corner icon is used to temporarily
close the program window, while the third one (X) is used for final closing.

2.3.8 Zooming

You can adjust the size of your plan by using one of the        icons or the
equivalent Ctrl and a character hot-key combination. Let’s see the effects of the
icons and the hot-keys.

Ctrl - Zoom in on the image in the active window. If the image becomes
too small to zoom in again, then further execution of the function will be suspended.

Ctrl + Zoom out the image in the actual window. If the image becomes too
large to zoom out again, then further execution of the function will be suspended.

Ctrl W Zoom out to an area defined by frame. You select an area with
a frame which you want to zoom out to fit to window.

Ctrl EZoom to plan size. You may zoom the whole plan extents to fit to the
active window.
Ctrl Shift E Zoom all to plan size. You may zoom the whole plan to fit to window
in every view.



Roof Designer-29

2.3.9  Using the cross-hairs
With the help of this icon, you can display cross-hairs beside the small arrow.  Often
times when you edit, it is necessary to see how an element is placed on the screen
relative to other plan elements. For this purpose, you may use cross-hairs that run
along the arrow horizontally and vertically in the window. You can turn on/off this
function with the  icon. The cross-hairs appear when the icon is picked. This
function is also activated by the snapping icons.

2.3.10     Using snap modes
For easier and more accurate editing, you can turn on/off snapping modes. To turn
on/off snap modes, use the icons. If the icon is picked, the actual snap mode is
toggled active or deactivated. Snapping means snap to already existing dots. You
can choose from more snap modes by clicking on  its     icon in the
upper iconline.

With this icon you turn on/off, the snap to grid dots mode.
With this icon you turn on/off, the snap to existing dots mode.
With this icon you turn on/off, the snap to lines mode.
With this icon you turn on/off, the snap to planes mode.

If you turn on a snap mode by clicking on its icon, then creating a new dot or
moving an existing dot will take the snapping mode into consideration. With the
help of snap modes, you can, for example, place a dot in line with other dots without
paying particular attention to the coordinates. Using snap modes, you can edit quickly
and more accurately. But of course in certain cases, there is no need to use snap
modes. The snapping icons also activate the cross-hairs.

2.3.10.1 Grid snapping
To turn on/off the Grid snap mode, click on the  icon.  You can display grid dots
on the screen. You may set the distance between grid dots in a given unit ofmeasure
unit in the Options/Editor… View/Grid dot spacing field. To make the grid dots
visible, click on the   icon in the upper iconline. If you would like to use the grid
snap mode, you have to click on the  icon in the upper iconline. The grid snap
mode works with the process of dot creation. If you activate this snap mode by
clicking on its icon, then you can create dots only on the snap grid dots. The cross-
hairs appear when activating the grid snap mode. You may shift the grid using the
F5 function key. To shift the grid to a desired dot location, follow these steps: move
the cross-hairs to the dot or position where you would like to place a grid dot and
push the F5 function key or select the Place Grid Here function from the menu
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which appears by pressing the right mouse button. The program will then redraw the
whole grid up/down left/right from this new origin using the grid space setting.

2.3.10.2 Dot snapping

Clicking on the  icon you turn on/off the snap to existing dots mode. You can
also specify a “sense range” to the snap dots. You may adjust the sensitivity of
snapping in the Options/Editor… View/Dot snap sense range field, but note that
the range is defined in pixels here. This snap mode also activates the cross-hairs.

2.3.10.3 Line snapping

Clicking on the  icon, you turn on/off the snap to lines mode. You may adjust the
sensitivity of snapping  in the Options/Editor… View/Line snap sense range
field,but note that the range is defined in pixels here. With the help of the line snap

 icon, you can move or create dots on an existing line. The line snap mode in the
active view always refers to the view of the line projected to the plane and not to the
three-dimensional view. So if you wish the dot to definitely be on a 3D line, you
need to snap to the line in two views. This snap mode also activates the cross-hairs.

2.3.10.4        Snapping to planes

  This icon switches on/off fitting to planes. Before using this feature, you have
to select at least three dots which lie in the common plane. Using automatic polygon
search (press  and click on a roof plane) is an easy way to select the plane which
you want to work on. After switching on the plane fitting, every dot creation apart
from automatic roof generation will produce dots lying in the chosen plane. For
example, if you create a dot using the Insert key, the third coordinate which is
perpendicular to the view of the active edit window, will be calculated. Plane fitting
is also working when moving selected dots.
Important: don't forget to switch off the function when it's not necessary anymore.
Deleting the dots which specified the fitting plane will have no effect on the plane
fitting feature.

2.4    Using the grid

It is possible to use a grid on the screen. You may set the distance in the given
measure unit between grid dots in the Options/Editor… View/Grid dot spacing
field. To show or hide the grid click on the  icon in the upper iconline. The
program gives you a possibility to use a grid snap method. To obtain this click on
the  icon in the upper iconline. This snap mode means snapping to dots. After
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clicking on this icon you can only create a dot on a grid dot. You may shift the grid
by using the F5 function key. If you wish to shift the grid to a dot located by you
follow these steps: move the cross-hairs to the dot or position where you would like
to place a grid dot and push down the F5 function key. After that the program
redraws the whole grid up/down left/right from your position by taking the given
grid dot spacing into consideration.

2.5    Changing the measure unit

You may select the unit of measure that you wish to use.
Select if you wish to design in centimeters.
Select if you wish to design in inches (inch, feet).

To move the cross-hairs, the small arrow or the selected dots on the screen, use the
mouse or the arrow keys.

2.5.1     Designing in centimeters

The mouse moves “independently” on the screen if no snapping mode is activated.
You may follow the relative coordinate position values of the mouse in the lower
data field. If you use arrow keys for moving, you may reset its increment steps using
the F3 function key. By using F3, you can toggle switch the value of displacement
from 1 cm to 0.1 cm and vice versa. The default value is 1 cm until you switch to 0.1
cm by using the F3 function key. To switch back to 1 cm, use the F3 function key
again. If you want to add to the increment step (to 100 times larger, e.g. to 10 or 100
cm) use the Shift together with arrow keys. The direction of the arrow key defines
the direction of the displacement from the actual position and in accordance with it,
the X-Y coordinates change. The coordinate of the actual position is shown in the
lower data field. You may reset the lower data field by using the F4 function key.
With this function, you locate a new origin at the cross-hairs’ and small arrow’s
position. You may displace the origin from the actual cursor position with a value
entered with the X and Y keys in the dialog box which appears on the screen. For
entering the horizontal/vertical offset values, a dialog box appears. The new dot
will be created offset from the actual cursor position with the entered parameters.

Figure 34. Entering the offset values
For moving dots, you can also enter offset values. Click the right mouse button and
choose one of the Move…/With Horizontal or Vertical Offset menu items in the
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pop-up menu, and then enter the offset values. The Move dots window is equivalent
to the window shown in Figure 34.

2.5.2     Designing in inches

Using inch-based designing coordinates are shown in feet and inches. Cursor keys
move the cross-hairs by one inch or 1/16 inch depending on the state altered by
pressing F3. Shift+Cursor keys cause one foot or ¾ inch movement. See 2.5.1. for
more details about designing.

2.6    Returning to the drawing window of myHouse

Using the  icon, you may return to the  drawing window of myHouse . When you
return to the myHouse program, your designed roof will be available to apply to
your floorplan. In the myHouse program, if you select a roof, and call the Roof
Designer program, the selected roof will be transmitted to the Roof Designer program,
so you can modify its elements and when you finish the modifications, the roof will
be re-transmitted by returning to the myHouse program. Thus, there is a two-way
data communication between the two modules. For calling them, use the  
icons.

3 The right mouse button click pop-up menu

You find main functions in the right mouse button click pop-up menu. You will
often execute these useful functions and the same commands can be found in other
menus as well.

Figure 35. The content of the pop-up menu
Let’s review the menu items one after the other.

3.1    Create dot here    Ins Creating a new dot

By picking the Create dot here menu item, a new dot will appears at your cross-hairs/
Creating a dot with Ins key: you can also create a dot by pressing down the Ins key
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when the cross-hairs and the small arrow are at the desired position. This is often the
fastest and easiest way of creating a dot.

3.2    Create…

If you choose the Create… menu item, a new window rolls down where you can
adjust the offset values of the new dot according to the position of the cross-hairs.

Figure 36. Specifying the offset values for a new dot
To specify the horizontal/vertical offset values, a new menu window appears where
you can enter the desired offset values. The new dot will then be created offset from
the cross-hairs the specified amount.

Figure 37. Entering the offset values
You can also enter altitude values for a dot, if you create the dot in the X-Y view
window. To use this function, choose the With Altitude menu item, and then enter
the value in the window that appears. The new dot is created in the active window
offset to the entered altitude in Z plane.

Figure 38. Entering the altitude value of a dot

3.3     Delete Del Deleting dots

Choosing this menu item, you may delete selected dot or dots. You may also delete
them by using the Del key. By deleting a dot or dots, the lines and planes will also
disappear from the roof. Before deleting the dots, you will receive a warning:

Figure 39. Warning before deleting dots

Confirming by answering Yes to the question, the deletion takes place.
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3.4    Connect C Connecting dots

You may connect the selected dots with a line. You may select three dots at the same
time and make a triangle by connecting them. These created lines become a part of
the roof and thus are visible lines in the 3D view.

3.5    Connect as helplines Shift C Connecting dots

Choosing the Connect as helplines menu item, you may connect the selected dots
with a line. You may select three dots at the same time and make a triangle by
connecting them. These created lines are light-colored. Their aim is to help editing
(they are useful when fitting to lines is turned on), or to create edges to close polygons,
so that these polygon edges won't be visible in 3D rendering.

3.6    Disconnect D Disconnecting dots

Choosing the Disconnect menu item, you erase the lines that connect the selected
dots. The dots will now be independent from each other.

3.7    Creating Arc… Creating a dot by creating arc

You can create a dot by creating arc. To create an arc. you must select two dots.
Then click the right mouse button and choose the Create Arc… menu item in the
pop-up menu (see Figure 35.). From the following two dialog boxes which dialog
box will appear that depends on the position of the two dots.

Figure 40. The necessary dialog boxes to define the direction of the arc
You must enter the following values in the dialog box:
Radius: The radius of the arc (in your chosen measure unit)
The Arc value is a semi-circle’s radius
Number of sections: The number of straight lines that connect the arc.
Please pay attention to the number of sections in order to avoid both the creation of
too many dots and un-smooth curves.
Connect Side: Select to connect the dots immediately.
Type: To define the direction of the arc.
By selecting your dots in a consistent manner by relative position, this setting will
help you get predictable results.
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3.8    Polygons… Making polygons (planes)
Selecting this menu item, a submenu appears which has the following functions:

Figure 41. Menu for polygon operations

3.8.1    Make polygon    P
You may construct planes onto the selected polygons. To make a polygon from the
selected dots, use the P key or choose the first menu item. If the dots do not lay on
one plane together, then you will receive a warning message. The two possible
warning messages are shown in Figure 42.

Figure 42-43. Warning messages during making polygons
First you must fix the fault and after that you may make a polygon from the selected
dots. To verify the polygon’s existence press down the S key. This time you will see
the polygons red shaded.
Use the Select polygons mode (by clicking on its icon) is an easy way to make
polygons. In this mode, if you click at any location, the program will search for an
enclosed plane figure nearby and changeits color to red. If there are more than one
plane figure overlapped, you may then alternately select plane by plane by hitting
the Space bar. Using the P key, you can make polygons from this set of dots .

3.8.2    Delete polygon
Selecting this menu item, you can strip the polygon from the selected dots. To verify
the polygon’s existence, press down the S key. After deletion, tthe plane will no
longer be shaded red.
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3.8.3     Show polygons      S Showing the existent
polygons

To verify a polygon’s existence, press down the S key. Now you will see all the
polygons shaded red. The roof contour polygon will get shaded green.

3.8.4 Create All Auto generating polygons

You may ask to auto-generate polygons from your created set of dots and lines. After
calling the function, the first found polygon will be drawn in red. Press Space to
cycle through all the found polygons. You can create a polygon from the currently
selected set of dots by pressing P or using the right-click popup menu. Use the P key
or choose the Polygon/Make Polygon menu item from the right mouse button click
pop-up menu to make polygons from this set of dots.

3.8.5    Create ground surface Auto generating surfaces

By the help of the Roof Designer program you have the opportunity to create ground
surfaces as well by indicating certain dots. Later, you may use the surface for a roof
or terrain. See the details in Chapter 5.

3.9 Changing move direction (Tab):

When you want to move dots only horizontally or vertically, you may set a move
direction. You have two ways to do this. While pressing down the left mouse button,
hit the Tab key and move the dots in the desired direction indicated on the screen,
or simply click the right mouse button and choose the Change move direction
menu item in the pull-down menu (see Figure 35). When moving a dot or dots, a
two-directional arrow appears on the screen to show the move direction.

3.10     Moving elements

To shift the elements shown on the screen, you must select them first.
If the         icon is selected, you can select a dot or dots. It is very simple to select dots.
· Click on the dot – which is represented by a small circle on the screen – you

wish to select with the left button of the mouse.
· You can also select a dot or dots by framing an area (hold and drag left mouse

button).
To indicate your selection, the color of dots will change to red. If there are dots one
above the other in the active view, then you can alternately select dot by dot by
hitting the Space bar. In other views, you can easily check the selection of the
proper dot. You may select more dots one after another. To select dots one above the
other at the same place, you have to select the dot twice. The selected dot or dots are
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red-colored. To delete the selection of a dot, you must re-select it.
You can select a dot or dots by framing an area. In this case, every dot, line and plane
in the frame will be selected. This selection is also indicated by color change to red.
You may move the selected dots. There are several ways of moving dots:
· With cursor on a dot, you can move the selected dot or dots by clicking the left

mouse button and watching the X-Y coordinates shown in the lower data field
as you move the mouse. For further details on changing move directions and
using snapping modes that may help you, see Chapter 3.9.

· When using arrow keys or Shift and arrow keys for moving, you step by
centimeters or meters (in case of inch measure units, you step by inches or feet).

· Clicking the right mouse button and picking the Move… menu item in the
pop-up menu list, the following window appears where you can choose the
right function for you.

Figure 44. Entering offset values for moving dots

3.10.1 With Horizontal Offset

3.10.2 With Vertical Offset

You may move the dots with an offset from their current position horizontally or
vertically. Enter the offset values in the dialog box shown in Figure 45. You may
also move in both directions at the same time.

Figure 45. Entering offset values for moving dots

3.10.3 Moving to cursor

You can also move a dot or dots to the cross-hairs.

Figure 46. Moving a dot to the cursor
Choose the Move…/To cursor menu item or then press the O (letter O) key.
In this process, the connecting lines and the planes will be shifted as well. If the
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planes would deflect due to this move, the program will suspends the move with an
error indication, and you can decide whether you want to continue or not.

Figure 47. Error indication due to dot moving
If you answer Yes, the dots will be moved to their new position in such a way that the
deformed roof planes will be deleted from the roof. You may verify this by visualizing
the planes (S key). The planes defined by the polygons will be shaded red, while the
empty polygons will get shaded green.

3.11 Locking selected dots

You may assign a special attribute to the dots so that later you may select the dots but
cannot move them. Clicking on this menu item, you lock the selected dots. The dots
will stay at their position and you cannot displace them unless you unlock them first.
Of course you may use these dots for other functions (like connecting them with
lines, defining planes, etc.).

3.12 Unlock dots

To release the locked dots, use this menu item to allow you to subsequently move
them.

3.13 Coordinate reset F4

You may reset the coordinate-system origin to the cross-hairs’ current position so
thereafter the X,Y values will appear relative to this new position in the lower data
field.

3.14 Place grid here F5

You use thus command to shift the grid to a dot of your choosing. The program will
then redraw the whole grid up/down left/right from this new origin.

3.15 Redraw all F6

Sometimes you may find “ghost marks” on the screen that you may clear in refreshing
the screen by choosing this menu item or by using the F6 function key.

4 Automatic roof-designing

This program gives you an automatic roof-designing option. For this you need to
draw a roofedge-contour in the X-Y Top view when the automatic roof-designing



Roof Designer-39

dialog box appears by clicking the right mouse button on one of the lines. Here you
give a definition for the rising slope ledges and the roof becomes generalizable.
Steps for automatic roof-designing:
1. Creating dots to the roofedge-contour;
2. Connecting dots with lines, forming an enclosed polygon;
3. Defining a contour line with an enclosed polygon;
4. Calling the automatic roof-designing dialog box by selecting the contour

line;
5. Inputting the definition of the sloping roof egdes by the side of contour

lines and generating the roof in the automatic roof-designing dialog
box;

6. Checking the roof and substituting for faulty roof planes
7. Saving the roof or transmitting to the floor plan program

4.1 Creating dots to the roofedge-contour

The Roof Designer program can be called directly from the drawing window of
myHouse. In this case, the wall-contour from the drawing window of myHouse will
appear in the Roof Designer’s windows. The color of the floor plan in the X-Y Top
view is light blue, while in the Side view you can see the floor plan as a single line.
In this case, you see that the wall contour is flat without any vertical (z dimension)
height. (Figure 48.)

Figure 48. Wall-contours from the drawing window of myHouse
Let’s create dots to draw the roof edge in the X-Y Top view.
It is most practical in this case to create dots and turning on the dot snap function by
clicking on the  icon and then pressing the Insert key or choosing the Create
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dot here function from the right mouse button click pop-up menu. (See Figure 49
below.)

* You can create dots by continuously creating dots, lines and polygons. After clicking
on the icon, you may create dots by pressing down the Ins key. This method’s chief
advantage is that the necessary lines and polygons will be created at the same time.
You can suspend the dot creation by clicking the right mouse button and at the same
time closing the polyline and making a polygon by againg choosing the right menu
item from the pop-up menu.

Figure 49. Creating new dots

4.2 Connecting dots with lines, forming an enclosed polygon

After selecting two dots, you can execute the connection between the two selected
dots by pressing the C key or choosing the Connect function from the right mouse
button click pop-up menu. After selecting two dots, you may make arcs by choosing
the Create Arc… (Figure 50) command from the above mentioned menu and
entering the radius of the arc.

Figure 50. The dialog box of Create arc.
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Please note that by drawing a polyline  you don’t have to connect each dot
pairs, it’s done automatically.

4.3    Defining a contour line with an enclosed polygon

You can get a defining contour line with an enclosed polygon from the Edit/Roof
contour…/Build path or by pressing the Ctrl-K hot-key (Figure 51). First of all,
you need to select the dots that you wish to form as a polygon by framing them – or
pressing Ctrl-A (Select all) to select all the dots. You define a contour line with the
selected dots by the above mentioned process or pressing down the Ctrl-K hot-key.

Figure 51. Transform the selected lines into roofedge-contour line
After the definition, the small circles that indicate the dots disappear from the junctions
of the polygon and thus you have created a special series of roofedge-contour lines
that form an enclosed polygon.
Please note that you also have a possibility to – if you wish – revert the contour line
to its previous polygon by calling the Edit/Roof contour…/Remove function or
pressing down the Ctrl-D hot-key.
And the Edit/Roof contour…/Clear own function helps you to delete it if necessary.

4.4 Calling the automatic roof-designing dialog box by selecting the
contour line

Position your cursor to the contour line and select it by clicking the left mouse
button. In the dialog box which appears, you can then enter the definition of the roof
plane for the automatic Roof Designer.
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4.5 Inputting the definition of the sloping roof edges by the side of
contour lines and generating the roof in the automatic roof-designing
dialog box

Figure 52. The dialog box of automatic roof-generator
In the above dialog box, you can assign the roof planes to the selected ledge. Here
you can define the ledge and surfaces you wish to generate by selecting the contour
line of the slope. Technically this contour line is the section cut of the roof on the
plane square to the roof.
Contents of the dialog box:

functional iconline
definition field
the field that gives default width and default height
roof plane number field
pediment assigner field

    informational icon and

OK and Make executional buttons
Let’s review the meanings of these icons and field elements one by one.

4.5.1 Functional iconline

 You can define a New roof plane. By clicking on the icon, the program assigns a
new number to the roofedge-definitions. This number is shown in the Shape field. You
identify the roof edges with these numbers. These light blue-colored numbers will be
shown in the plan view of the roofedge-contours.

 Using this icon, it is possible to Delete existing roof plane-definitions (shape).
The current definition can be deleted from the assignment to the roof by clicking on
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the icon. The roofedge-definition will be deleted from all of the contourlines which
contain this numbered definition, so you will have to assign another definition to
them.

 You can Load a saved roofedge-definition (shape). The file extension of the roofedge-
definition is SHP. In the displayed Open dialog box, you can choose a file name, which
will be assigned to the number shown in the Shape field.

 You can Save the existing roofedge-definition (shape). The file extension of
the roofedge-definition is SHP. In the displayed Save dialog box, you can assign a
file name to the shape to be saved. It is well worth saving typical definitions so you
do not have to define the same data (shapes) again and again.

 You can Clear a selected definition. The function clears the definition field
and assigns a new definition to the number shown in the Shape field.

 Using this icon, you may set the roofedge-definition shown in the definition
field and numbered in the shape field to all the roofedge-contours.

 A roofedge-definition can be formed as an arc. You can make it by calling the arc
generator. After clicking on the icon the following dialog box appears where you can
enter the arc values:

Figure 53. Entering the rising arcs of the curved roof.
Curve Height (Y): The height of the arc
Curve Width (X): The width of the arc.
With the help of these two values, the program divides the arc into 8 parts, and you
can see these values in the definition field after clicking on the OK button. The
value of X Y is the sum of the values in the dx, dy fields generated and shown in the
definition field. You can make further modifications on the contents of the definition
field after the arc is generated.

4.5.2 The definition field

In the definition field, the program defines a series of sections in one line as shown

in the  icon.
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The data definitions are as follows:
X horizontal overhang
Y vertical elevation
Alpha degree of the sloping ledge
dx length of the sloping ledge in the x direction
dy length of the sloping ledge in the y direction

In one line you can see a definition of a series of sections shown in the  icon.

The roof can be built up by the side of these ledges as intersections of planes. To all
the roofedge-contours, a definition must be assigned, which can be the same or
different per pages. The definition is identified by its number. A ledge’s plane-
definition can be formed of 8 definitions and the rising roof edge can be composed
of eight successive sections as shown in the icon. In each line, the X, Y values can
be entered or omitted. The degree, the value of dx, dy are interdependent on each
other. When entering values, you can choose which two values of the three you
know and wish to enter, and the program will calculate the required third value. If
you wish the program to calculate that required value, then you need to fill in the
other two and after entering the third field, clear that and hit the Enter key. The
program will calculate the new value and write it in the field.
Comment: When you use this calculating method, some rounding inaccuracy may
take place. The elemental values are the dx, dy values. The value of alpha helps you
to fill in the definition field and is only used for reference value.

A roofedge-definition can be assigned to all the planes with the help of the  icon.

4.5.3 The field that gives the default width and the default height
The field that gives the default width: The roofedge-contour starts further out
from the wall perimeter by the value entered here. Using this function, you can get
a larger eave overhangs.
The field that gives the default height: The roofedge-contour starts higher by the
value entered here. In order to be exact, the roof contour is considered 0 base level
and the value you enter is offset vertically from this 0 base.You can vary the values
for the roof starting height.

4.5.4 Roof plane-field number
This is a number in the field, which identifies the roof edge definition shown in the
definition field.

4.5.5 Pediment assigner field
A pediment may belong to an eave. In this case, you do not need to fill in the
definition field, you just have to indicate that there will be a pediment on the eave
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adhering to the plane number. The Roof Designer program does not generate a plane
to this eave. The walls located on the floor plan will be automatically built in, and the
other planes of the roof may cut them down. Default width is the only numerical
parameter that has effect when a pediment roof shape is selected.

4.5.6  Information icon

This icon explains the meanings of the values shown in the definition field.
The data definitions are follows:
x Horizontal overhang;
y Vertical elevation;
alpha Degree of the sloping ledge;
dx Length of the sloping ledge in the x direction
dy Length of the sloping ledge in the y direction

4.5.7 OK and Make executional buttons

OK Using this button, you can assign the definition to the selected ledges.
Make Using this button, the program generates the roof with the help of the
definitions.

4.5.8 Example for automatic roof generating

Let’s review an example for making a roof shape. Move the small arrow to the roofedge-
contourline and select a ledge on the floor plan by clicking the left mouse button. The
Roof plane setting dialog box appears to define the automatic roof generation.

Figure 54. Roofedge-contour above the floorplan.
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The definition asks the program for two types of roofplane-generation (See Figure
55.a,b).  You may enter the value of the roofedge in the definition field. In the type 1.
plane you enter a definition with two-tilt angle to the definition of the roofedge.
After entering the type 1. definition, you assign it to every plane by clicking on the

 icon and then you quit the dialog box with the help of the icon (See Figure 55.a).
In this way, you re-selected the type 2. edge contour definition on the floor plan and

you created a New plane by clicking on the  icon in the displayed Roofplane
setting dialog box, and so you indicated that this is a pediment (see Figure 55.b). You
may then generate the roof plane shape by clicking on the Make button. The generated
roof is shown in Figure 56.

Figure 55. The two types of roof definitions.

Figure 56. The automatically generated roof
Let’s take another example, where you can see that the tilt angle of the generated
plane could be negative (Figure 57.).
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Figure 57. The result of a roofdefinition has a negative tilt angle

4.6 Checking the roof and creating substitute planes for faulty roof-
planes

As you survey the result of the roof generation, you can see that in this example, the
whole roof generated is successfully done,  so you do not need to fix any incomplete
roof planes. If it was not successful, the program would warn you with a message
shown in Figure 58. You can then fix the missing planes by creating new planes.

Figure 58. Error-message during the automatic generating

4.7 Saving the roof or transmitting to the floor plan program

You can save the roof to a file. If you called the Roof Designer from the drawing
window of myHouse, then by clicking on the  icon, you can transmit the roof
back to myHouse and place it on the floor plan.

5 Generating surface

You can also use this program to generate a surface by creating special dots that you
may use later for either a roof or surface terrain. You need to define the external
contours of the terrain and typical ground elevation dots of the surface. There is no
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need for the dots of the top view polygon – the polygon that marks the terrain – to be
in the same plane. They can be manipulated arbitrarily. For example, create four new
dots and connect them with lines and raise two other dots to the same height and a
third one in the middle to a lower height. These dots can also be created by Create…/
With altitude function where you can define the altitude value of a dot in the dialog
box shown in the Figure 59.

Figure 59. Setting the altitude of a dot
Connect those dots to other dots which define the surface perimter. The result is
shown in the Figure 60. Note that one dot of the contour has not been raised!

Figure 60. Dots for generating surface
To generate the surface, you need to select one dot on the contour of the surface.
Clicking the right mouse button, you call the surface generator from the Polygon…/
Create ground surface.
Important: If the generated surface is not satisfying and you want to change its base
dots or contour, use Undo (Alt-BackSpace) to erase the generated surface. Before
returning to the floorplan editor you may want to save the surface contour (not the
generated surface) as another file (Save as… function), because it's not possible to
regenerate the surface in such an easy way like automatic roof generation can create
roofs.
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Figure 61. Calling the ground surface generator
You need to define the grid density for generating the surface. In the example, the
value used is 50 cms in the both directions.

Figure 62. Enter necessary values for the surface-generating

The generated surface is shown in the Figure 63.

Figure 63. Generated ground surface
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Comment: If you wish to make the generated ground surface smoother, you need to
create more basic equally spaced dots in the top view image, and the surface will snap
to these dots. You may also generate  a “hole” in the ground surface by using reverse
slopes.

6 Quick roof editor

You can start this function by clicking the  icon in the floorplan editor. If you start
making a new roof, after pressing the icon you have to define a roof contour in the
floorplan editor. You can do this by using the mouse. To close the contour either
double-click or click to the first point of the contour. You can edit an existing roof by

selecting it, and clicking to the  icon.

Figure 64.  Quick roof editor dialog
Contents of the dialog box:

functional iconline
definition field
field for entering default width and elevation height

informational icon

button for refreshing the picture of the roof,
buttons for selecting the function of the mouse,
statusline for messages about the roof creation process.

  Switch between cm and inch measure units.

 The function clears the definition field and the roof parameters.

 You can set the surface properties of the roof.

 Quit editing, erase the roof and return to the floorplan editor.
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 Save the roof and return to the floorplan editor.
In the definition field, the program defines a series of sections in one line as shown
in the  icon. The icon shows a cross-section of the roof as if we looked at it parallel
with the wall.

The data definitions are as follows:
X horizontal overhang
Y vertical elevation
Alpha degree of the sloping ledge
dx length of the sloping ledge in the x direction
dy length of the sloping ledge in the y direction
In one line you can see a definition of a series of sections shown in the  icon. The
roof can be built up by the side of these ledges as intersections of planes. To all the
roofedge-contours, a definition must be assigned, which can be
· normal roof  setting
· elevated roof or
· gable end.
A rising roof edge can be composed of three successive sections as shown in the
icon. In each line, the X, Y values can be entered or omitted. The degree, the value
of dx, dy are interdependent on each other. When entering values, you can choose
which two values of the three you know and wish to enter, and the program will
calculate the required third value. If you wish the program to calculate that required
value, then you need to fill in the other two and after entering the third field, clear that
(use Delete or Backspace keys) and hit the Enter key. The program will calculate the
new value and write it in the field.
Comment: When you use this calculating method, some rounding inaccuracy may
take place. The elemental values are the dx, dy values. The value of alpha helps you
to fill in the definition field and is only used for reference value.
The field for entering elevation height: The roofedge-contour starts higher by the
value entered here. In order to be exact, the roof contour is considered 0 base level
and the value you enter is offset vertically from this 0 base. This value is used for
those roof contour sides which are set elevated roof (see later).
The field for entering default width: The roofedge-contour starts further out from
the wall perimeter by the value entered here. Using this function, you can get a larger
eave overhangs.
The Refresh button updates the top-view picture of the roof. However, pressing the
button is not always necessary because pressing the Enter key after entering any
roof parameters has the same effect.
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You can customize the roof by using the three different roof defining types:
· normal roof ,
· elevated roof or
· gable end.
For each side of the roof contour, one of these types are assigned. To assign a type to
a roof contour side choose the type with the buttons and click on a roof contour side
on the top view picture of the roof.
Use Normal roof setting for the sides on which the roof is not elevated. Using
elevated roof will shift up the roof planes by the value entered at Elevation height.
Choosing Gable wall setting will result in a vertical cutting of the roof at the specified
sides. The three types are shown with different colours on the top view roof contour.

Figure 65. Using different type assignment to the roof contour

Figure 66. Defining multi-section roof shapes
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